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Computer System

C52401

m> HEIE TUITEAL 5
e 5‘%

T TR B TET- T Toh oh ShPe, YU Py, HAthH el 3N
Uil HTgsh! SFF |

1.1 9 HFIEI o IR W FIT A 82

ICERNE FHFII (Computer)

FFIEL Th FARRI [k HRMH & ST $HYL-TEH-3TILYE o FHgid ot s el ¢ |
& fr=ferRaa Jer @ 993 ST 9ehar &

gl
5

o 1.2, Frege usran
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1.2 ST <h ¥ceh (Components of Computer)

PR o AT T @ S A1 (9 T &:-
1. 379 feaTsH 2. ST oy
3. J3eYe fearsH 4. RS fearza ()

1.2.1 379e {2139 (Input Device)

$YC TEaTsd o8 STEAar fSaTgH Bid @ ISHehT SANT hFel H SIeT 392 il
aﬁ%ﬁ(instmctions)aﬁmﬁ%mﬁWTW% | WFW@W
4 S1eT AT ST e sht HAR | wufed foher Sitd 8 ud (e fou St aehd 2 |
S - SIS, HISH, TohL 3R ATSShIhH SIC feaTsd o s T < |

v

§

Mouse Scanner

Keyboard

o 1.3, 39e feamsw
1.2.2 Eﬁ'@'ﬁFﬂT%ﬁE‘H (Processing Device)

FFS T "HRASH" IThH! Hedd AT gfe (Hd) | 78 Tomret 37K
T3t 1 T8 (Process) T &, fSrert aftorm s1seye feamse W wefRia forar
ST GhaT 2 |

o 1.4, iRy (deat TrafE gfe)
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1.2.3 3113eUe feam3H (Output Device)

313<qe fearmse o€ fearmsd Bid € ST fdu T Tl ol T i o o1g STFNTehdi
&1 giom fafi= gream (Serewr- e, siifem, fafsan, mitrea sanfe) & wefifa
AT | HT3YE TSarTsd o % 3200 &- Tfiery, Histarey, fifey, Hifet afa |

o
0
TteRt

o 1.5, fSeqe feamsw

1.2.4 9HT (Memory)

FF WA o8 Tearsd BIdl @ TSret SEqHTel STeT 3R Gl shi R i
o ToTT foram STTaT & | HHRT  STeT amgd (0,1) o &9 H R BT @ | el WA
FTE SR ITSYE ST Yo 6 ST hl TR HLA H F&TH Biell 2 |

Wﬁﬁﬁaw?ﬁﬁ%— TTeIfireh AR (Primary Memory), fadiaeh
T (Secondary Memory).

1.2.4.1 STerferes AERY (Primary Memory)

Srrfirer HERY 98 STfe BHRE 2, ST ER % fore rer o1k frden s e
AT T | FT ITEATE Bt & 37T FF T T W T WA & T8 v R |
ITTEeR A o T 2:-

1. RAM ({sH T=0g o)
2. ROM ({E 1<t 7o)
3. Cache Memory (%QT ﬁﬁﬁ)
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1.2.4.2 Tgditares Aay (Secondary Memory)

FFLL o6 I8 HART [STEehT TN SMeT T TUTH ol Tl &9 & wfed i
o foru forarm ST €, Tecfiaes Aat FeatTd! © | 38 e N off had § |

1.2.5 BTEa (Hardware)

PR o o8 T WifcTeh | {57 1 B 371 @ Hehd ©, BTSA healld & | 376
! % STAR 3¢ [T~ AT § forTiod foram ST &ehat & | fafeT sreaer
feaTed, 39ehT ST e IereLor il § fau 3 -

fearza ITIT ISTELT
TR TN Fesr A & feu frar st w1, e,
TR Serfes TR
P T IUANT fU T ST Sl e
& foTu foraT SIaT 2 | i

HEeUe  I% oH FrAR T o T S

: NI H7fHex, fiex, Tt

TToRT 3TN STeT ohl LI R 3T TS fet, S,

e T o fore fepam ST 2 | i, U ST

TTgfore fearga- UM fearsy fSieh ST @ 87 39e < Whd & 31 STReqe i o
Gohd 8, TTEIsTS TSaTed hadTd & | 8- Hisse %M, [FPD (Interactive Flat Panel
Display), s¢ic9 2SHH |
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IFPD Sy eI
== 1.6. Trefore fearzw

1.2.6 AT¥EAAR (Software)

HTESL AT T Uoh W8 & ST SUART et shl HAToTd shil 31T foReT
forRI Tl Bt FeeTerd ot o ToTT o Wkl & | B ETUHCAa h © T8l |ohd @ |
TTFZAI G 31 ThR o Bl 2:

1. forew wiveam
2. UCA TR 9T ATFEAAT

1. foreew |Twea=r (System Software): FEeH HIwea Ho &9 & FHFgel i
ol RIS ST @ | 98 U T8 H BTEaIT I ST U Tohe e o sfi< 2ThE & |

Treew ATwea=r o serevun: AT fawen (foer, Oe, forme ftmfen fawen

% 3T ©), fearey grgar o< |

Window OS Ubuntu OS
o= 1.7, Ty gigear
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2. qﬁmﬁw—r#’mﬁm (Application Software): %WW%WWE@
3 i el e o Bt o e o6 o R foert e @ | weehiabert et
o IS © - I8 YT ST9eaIT, Uthad HTFEAIT, TSeyH TR, fafear
TR Hie, TeIfoitT iteaa, fefenfém direder a1fe |
> S MU THT AT (Word Processing Software): QHWWE@I

I HFYI H TR TEY HAT © | THUE-AE, I€ U, fofsl SHTithe e o€
TR BT 6 7 SaTe |

MS-Word Word-Pad Libre-Writer
THUH-aS CEA- faeEeR

= 1.8. 9 MeftT giveamr

> TtheRT ATFaTT (Graphics Software): U8 GT92aR & feient Suamr fo
(images) &1 a9 R EUTfET (edit) o fog foram Smar 2, mfteer
T FEd @ | S T UThad Wit ST § — seiet, Blemi,
FA U2, HTereteh U 371 |

> USIevT ATeaa (Presentation Software): I8 TATohd HTRAIX i
us Auft & SRt fese oy &9 O IugimeRdatel & text, images 3R
AT/ fafean o1 U ATy STige ISIe (presentation) S o foTa fopam
SITT & | I8 HET YA, STHRRT T 3l H T8TaH ¢ |
REIERIC] TSI HTRAH 8- Microsoft PowerPoint, Libre Impress,
Google Slides 3 |
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Click to add Title

Microsoft Powerpoint Google Slide Libre Impress

== 1.9, TSI Wit

1.2.7 WHAIR (Firmware)

FHIIT Teh TUTH 2 ST BTSIIT SUSKIUI hl HoTierd shi o felq | IAhT AT
T urere foRaT STTT ¥ | K- A, HieTee B, et fudie onfe A gere s @
T i H TEh BT ¢ |

1.3 ?:FFUQC\Z'{‘QI'?WT (Use of Computer)
ST fafer= et # Suat §, Ja:-

> I - S SO hT SUANT =T il S~ TR o §eed 3T e
IS S, S UHe, 3-0d, Tafestl s, TieH g = Feiaas
SR ITH i SeTie § fomam ST 2 |

> STTATT | - IR H TRT-11d, A-a, Toishl, 7ok 3 oht g ST
& TY-ETY dfehT 3T ek ST S &F F HehiT ¥ Tre-ad Ao aay
STRRT SITH 3 H Pt h ST fohalT ST 2 |

> framea 7 - fo=ne™ °§ ATdTsT e, HATaATsT TheTd , gde iy dIm
U, ferarfert o Fehte Ta, Jemod, ATgsil $eatie | HFeet st udnT fora
ST |
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> Sk | - UTEeh o1 WAl @I, A-8, TTEhT ehl STFeRT WaH, SATHATST ST
HaT 3TTE ST o oI Sfeh & Pt T ST ol ST & |

> AT | - PR o G TeIfehcd 19 STier ¥ foh AT, SEiST, T
HTfe shl ST @ | ST H T skl E2feh ST AT AT FohiS Pt g Tn
ST |

> TAT A ¥ - 3o, fuamsa, s, Sie ST 8HT | SEa9Tel 819 aTel el Sqehtr
FFI I A 81 € o |ideh e W o & | T8 & § wweiferd
TECAUT SIFERTIGT 2hi T &9 & HHTHA i  $oH § U8 ¢ |

> EATAT | - HFYS FHRT 1 Th A T 2 | T G, sl
T, dTEHT HAT, hodded FHATAT § ARt FreaTad scaTe § ot
FRITT R FHFI G AT ST 2 |

> AT ¥ - ST H FHFRIL ST Th{d A, ST HURIA L, forsedwor
T I ST I ATTehd i oh TIT ITANT TohaT ST € |

FPEIR W - 3-0d, 9ivre difear, fafsar bt o afia dewr enfe d=r
o ToTT FHFIET ohT ITANT fohalT ST 2 |

> - A R e oo ot o ToTu, 3 o SATTEA 3T 6o ot STHehidt o
T FFrege 1 S9aT foram STTaT 2 |

AT +ff ST T ITE ST b R, TP T SHANT FHel-Hal (ohal STl
2|

1.4 EFFUGC\?.'{'SFET‘JT (Benefit of Computer)

v gedierienT (Multitasking): Tk & @9 | ggd g & (tasks) AR
LEGiENE] (applications) shT TINT foRaT ST Ok 2 |

v/ T (Speed): I T TEH ST ATH I6eh! STHEH T &, S FHD &
&1 | e 7T STl edTied AT @ |
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v "&HAT (Accuracy): WWQG%’@G{W% chlef‘ilﬁ glehdT & 919
qrTfed AT ® |

v/ STETHET (Data Security): FFR ST i HTT TG 34 HehiHd &M, TR
B, T 2T H ST & o= o1 i T g |

v/ H9R (Communication): T STT qAT TS T &M T&H FA §
TR 2 |

v/ SUSTUT (Storage): P S AT § STHEIM qT ST i TR T el
2 | ST ohl Sohelt B feargy § oft gufed feram sTasrar 2 |

v TEETEAT (Automation): FFRL T HERAT § FgA X HAT bl L=TTerd
Toar <7 wehar B, S8 bl T Y e BT R |

1.5 TR | HHTTd gT-ar

> ST - PR H AT T WA ST T8 & | ST o HTEAH § S Hecaqut
SRR ST 1T bl Y AT A T GEUAN THAT ST Hehell € | AT oh HL0T
FFRIET 1 T ¥t 5 B Hehel 2 |

> TTSa hTSH - HTZR higH ohT 3T § St auT fefSTeet Sushiunt o Arem |
IS YUY HLAT | $6H TS GraTaet, ST, 2o 1 37T shige e
T SRRT TUAT AT TR A 2 |

> AT FEET-2IT FHEATY - FHFREL 3 AMAR ST FL § THR TTET T
S8 S TTS U Hehell € | 9 AT HASIL BT, THIS SIg o Hror-ame &,
T T FHL B €8 AT BT HehaT © |

> TATEUT - 9 HFIEL @ AT ST BT ST & A1 §6eh s MW bl b
< & Toree gaTr = ieroT gfvd Biem € |
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https://ehindistudy.com/2022/05/14/virus-hindi-types/
https://ehindistudy.com/2017/05/26/itact-2000-hindi-cyber-crime-hindi/

v/ PRI T ToIa 1ok AR & ST $TYC-THE-3TICYE o TG/ IL T Ll
g

v/ AFeaR o T&d T B ©- Teen Hiedat 3 Ufterehe diTear |

v Ufterehy ™ Eigeaa ohi foreY faf3re sl oht v o foru festreer foram mam 2
T ST ! T o T 1 forel foreIs TehR o e oh STEH HTe H Hag o]

2|
v/ FHFR o T&T AT &- ACSIIRERT, T, HEThdl, STeT YUall, §ar, Her
(Storage), =T |

AT HT

1. frm & & =it 3Ue iR ereeye fasw @ 2 fu u vrsat 3
T
A TSE
B.#I-aE
C.fiex
D. HTSShIBH
E. Tt
F. "X
G.Safesh :
2. Teu U want ® T foenew ot o it |
[. PSR STET S TELHRM T HEATd & |
(2) FIE (b) STETET
(c) BTT (d) iSee

Page | 10




II. P o |t Hifereh fearsy seamd © |
(a) HTHRRT  (b) TEAR
(c) STt (d) ATERA

[II. Tk IYHLT ST HFSL H 1T Ufafl s § Hag hidT &, FHeelldl ¢ |
(a) T fearse (b) TAfET farge
(c) ITSYL feamgw () @l

V. J8 39T ST e O fohT 1T T 3 G21id @, FEATd & |
(a) e fearsd  (b) Mafe feamsy
(c) IT3eRe feamsq (d) wft

1. I Y HTSTYL HISE & ST

2. frgporer feewer e

3. Y9E &Y ¥ 39A1H 379 fearsd

4. ST THF T ST A o foTg 3umT

5. P H $TYE HISES/AT5H B SUAIT

6. HISH shl aLE ST
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4. FreaferRaa wat & s o
a. FHFFSTHAR] o TehR [T |

5. TR T
foremeff ICT oe H STt $YE 3T HTSLYL BTERK o UIEH i W | TIEH
G o A1E T 1S ok H $YE H HTIYE BT hl TICATHT o6 |1 Ik
IaTee ot frfta |

oterer o foru fAcer: f3rerers foenfefa sl ICT A9 0 & STt 79/ § q1g
T hFg X % Tk (Components), BTSRR 3T BRI ! UV |
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m ‘Fah T hIUT

2 Storage Devices

{mwwﬁnﬁ'@:
® FFRTE?

® FF Y FHTH AT Q ?

® 36eh BRI HN THAM |

2.1 @B{W%EI'I'{HW% ? (What are Storage Devices?)

TS fearsd 98 IUeRtT Bid 8, Sient SuanT aeqatl sl gufard T o g

Torar STTaT 2 | Seretur-31arH i, Sheiey, siem, fesd ar1fe |
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THT TG P hl Gl hl U T 3 [T NS farse (HHI)
YA foraT STTaT ® | B et afientor o 2.2 7 fear man E |

Memory
)

=

Primary
Memory
| l ‘ I ‘
RAM Cache Optical Storage Magnetic Storage Flash drives

forsr 2.2, 99K = affeRtor
2.2 TTATHeR HH Y (Primary Memory)

STerfees HARYT i PRI shi & A Hl 8T ST & | I8 Fred 9
foTT STTa9Teh Bt ® | I8 1 TohR shl BidT & — 19, UH 3T HI J9R]T | 3=° 3Tidiieh
YSUT (Internal Storage) o &9 & off THAT AT R |

RAM ROM Cache

= 2.3.7 @\, Um Sk

Page | 14




ATCTeRT 2.1 . T, T 3T SH9T AR o el 3T

I8 Sl OuH) 9% e 3R (Non- I8 Uk 3TETS HARI R |
(Volatile Memory) 21 Volatile Memory) ® |

TEEhT TG O @ T T R MA AR | 6ok T1d See asl © |
THRT | STETTR R |

IE HFYT o I SIETh FHHT ITANT HFIL hl H3 HAMT €
duRd AT e M AT =] 0 o fog foRam ST i ol srewelt & |
T ol ATEIFAT ST 8 | QTS |

2.3 Tgetarer WAt (Secondary Memory)

feetares AHRY Uk IR T non-volatile FAIE & 5@ e (direct) W@W
TR T foRaT ST TehaT | Sehedt BERY et o fewr e Bt © 58 e §
37T © SATST ST @ | $HH STeT HR o fog TR T&dT & AT foh 3T HFeget ofg
ot g1 ST a1 g9kt e1eT fecfie 7t gaT |

TE TMeal § e ar “Feeiiares HHIT Teh JehI 31 hFeged HHRT & FSTaent U
e AT ATt SreT S (fafean, suw, edifean, wea, Tum, ddeasy o) =1
I o ToTq foram STt @ 17 Srgwdl Ha) 36t qorT | gHeh! T2 &7 SIfee
BT 2 | 98 AT 4 ST ol fecfie ST ST ST § | 378 oTel YeNur o &9 § ot
ST ST & | feefteres T &t Jehr &l Bt 8- SATTteehet T, B TS aT
TIST T |
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a) ATiteehcl TEIST (Optical Storage) : I8 fEITsH et sl €UfEd wi- &
I ud 3 U o ToTw yehTeT fohaolt (s sfiwr) T SURINT ST © | 3QTeT0T 6
fore =i, St o1t fewh seafa |

b) WTeeh TS (Magnetic Storage) :ﬁWUTHEFITﬁ ! fore 7 dufed
T o ToTT S[sTehTd TN oAl STANT L & | Hfesh SRS feamsd | Srer
T HFT, T AT ¢k H HH{Ce =TS (SHH- 0 o forg difstfed =mst 31 1 %
foru TAifea =) o &9 U H@ufed gt § | 39 IS8 - 8Ts fo&h, FaArd
feeh, Ao fewh seafe |
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¢) WAIT WA (Flash Memory) : 39 [Samgq § G-T3AT ol HLaT W@ &
foru foforerta o =1 ST ot € | 912 BT fowsh S 31 it feamsa &
T i atferes e 2 ¥ | Sarer ¥ for et e g, A T,
ﬁﬁ@@??{lﬁ (SSD), NVME (Non-Volatile Memory Express) TS |

Pen Drive NVME SSD
= 2.6. woiw A feazw
2.4 U AT ZehTSAT (Storage Units)

ST (GET3T) 31 HARY & HHfed foRa SITaT @ | HHRT SRS Sl 9ol 1St 315
&I fore (Bit) (ATsRI fefSTe 0 311X 1) & &9 5 ST ST & | Go1 §0av Al &HaT
YT 9T BT 3187 dlfetsT 2.2 T TS & |

AT eTeRT 2.2, HHI SohTsal

S U

8 Bit = 1 Byte

1024 Byte = 1 KB (Kilo Byte)
1024 KB =1 MB (Mega Byte)
1024 MB =1 GB (Giga Byte)
1024 GB =1 TB (Tera Byte)
1024 TB =1 PB (Peta Byte)
1024 PB =1 EB (Exa Byte)
1024 EB =1 ZB (Zetta Byte)
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——

> U IUHLT FSTehT STANT STeT ST G shi Hfed i ST IH: 916
T o foTu foram ST 8, 38 Wil feaga ar ami shed 2 |

> TH ol 31 YR § arfiehd foRam 7T 8 Smerfiren o7 feefiares A9 |

> WWWWﬁW% RAM, ROM 3 Cache.

> Tediaes 7 oiF o Sl B 8 Siifteshel LIS, AH{deh TR 3T
AT HA |

HETH

1. P H AR o7& JHR < |

A ) T N I o) TSR ST Sehedl HA

) HTZ 3T TS ) T SR I3TA
2. FFafafiga # o sreumrft 4t ® |

37) k3T o) ROM

) RAM 3) TS e
3, UEHG AR R |

3) U 3159 &) CD

) SSD g) RAM
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4.1 STEE TSR |
a) 8 foie
¢)1fee

5. RAM &I QU AH &
37) TeH THaE TRy
o) {0 ualy Hifiet

6. THAT hIfSTT |

b) 1024 Tere
d) 100 fere

P RUCRECE R R EA |
) T AT T

FLASH DRIVE

(AT BT3)

OPTICAL STORAGE
(HTTieheT TEI)

MAGNETIC STORAGE

(A @)

SOLID STATE DRIVE
GUSER A )

Page | 19




7. fafafad vt o sae s
A FHFIEERS € AT 1 G0 § 2

8. TTATITeR T
forameff ICT e § SRt 30 Pt Toeen ol dehedl WSHUT &HdT

[a N
SIEEANEIN

foreren o foru fcom: Rrereh foranfefat it red & @i feams@ ICT v e o
o ST fewd |
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Formatting in Word Processor

C52403

r . . D
Ul FedT ¥ g0 I8 TER (Word Processor) CAEIEIR RS ERUESEXE
S[& AT, T€ T (ST ol THFHT, SHTT, Hel AT, SRHE il ST TS

Gﬁ@wﬁaamw&m%l

J

I TR T IS TRITHT TeeAToheT AHeaRR & | 36ehT ST SIRpHE, T
R fraid arfe s & foTu femam SaT 2 |

foTsr Trge ¥ wiH T 3T Ut 93T

oSt et | e sl HiHe, TUTH BT, U W15 Ud SeRHe i e
T HET |
H'Tvl'ﬁ'%T(Formatting)

led 1 |
File Edit View Insert Format Styles Table Form Tools Window Help
B8 . £ ==
Spacing > Italic
Faull graph styl q single Underline A
Clone Formatting Double underline
rrrrrrrrrrrrrrrrrrrrrrrrrrrrrr gh
Character.. | Overline
aaaaaaaa h... Superscript
Lists Subscript
sssssssssssssssssssssssssss w
PPPPPPP le... Outline Font Effect
TitlePage.. @ | IncreaseSize
Decrease Size
Columps... | UPPERCASE
Watermar k... lowercase
cle
eeeeeeeeeeeeeeeeee
nd Sh pitali ery Word
m d Object  ~ >»|  LOGGLECASE
mall capital:
Anchor
Wrap
rrrrrrr
Flij
GGGGG
~
3.1 wie &
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foTsl SR TEex U g1 wile oo 37T § fierdr 8 | 36 3 o 37eT hiset
(Character), < (Text), SUTE (Paragraph) sl BIHTT 3T UST erget off 3mfiet
2 | iHE § W A aTet 9+t 7o, T8 AR A H 7 § | o o1 i o o <

ghd 2 |

Untitled 1- LibreOffice Writer

File Edit View Insert Format Styles Table Form Tools Window Help

[ . = ) 21 — p : = e

o) ;] :il L] = ;1 H e il A =0 Te s T L

Default Paragraphstyl ~ Ay Ad  Liberation serif vt v BIU-5 M A A-P-EEEE E-E.5 =6 2.1
3.2, @aw

TR AR NATE FETH S R A aier @ g |
wi-¢ (Font)

Hi=E T8I T Torg ot aiienT & fSTam 378/ vl fafsy=r &, 31mente, TT 31ife
Y forar ST 2 | 98 Uk & forft o 37em SRl 31T 1o &9 9 forgq st adisrr 2 |
forelt ive | ot ¢ wrft 378X o EHE 1 Bie Bl (Font Family) shgT ST
T |

Liberation serifF ~ 12 pt ~ B I U - =
Lohit Devanagari IR

Gargi AT I
HaTSd A 010

aakar evraidl @

Abecedanio
Abec eda-—'uu}_;:&umda-

Abecedanio nautada

Abvyssinica SIL

=33 . B s




T~ ATl (Font Size)

h1g oY Bive TordaT seT 37 BieT foE@Ts 2T I8 Wi ares ¥ fAuiig gar 2 |
HTT T & STRIHE H 31U ISR hl ST ITHT THR & Hohd & | Hiee AT h
T e Tol 3.3 H 39 9@ Eohdl & 12 pt forem g1 8 | 56 9 foreter ook 3119

- HTES I Tl § |

AT ITAT-TAT HIZTS o Bi=E o Tohd 8 | BI shl HICTS ohl U5~ HaT SITdl
2| s fu s@ S &9 pt feraT ST 7 |

3alalUl:

India - I8 Times New Roman %I H oI TRIT © 3T SHH %i=e 915 16 UTse
HE

India Jg Caveat ®i=e H foT@T TAT § | 30H Hive HTEST 20 pt § |

India 3= Pacifico B H f@I TRTE | 3F"}I i A8l 16 pt% |

India g [ obster wive # forem TIT & | SEW B AIES 24 pt & | &
WA |

thT-e TeTseT (Font Style)

e (Bold)- TR 3781 ! ST 3119 foreiy &9 & ffed shr =med 8t df 31 |
I | W hacl SHT I168 ohl ieg L Tohd ¢ |
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fot 3.4 13T TC SR § 39 “SqIST” I SIS L oo o | TReT 3T& AT
STeGT o T i SIeS L % [T 3T A=Y | @ 7T e § aies L T o
YT ShI-sTe “TiTeahe shl” Ctrl + B hT STANT ot HT ek € |

Arial;sans-serif ~ 14 pt ~ B I U-=<
X =
< = e e forar 81

== 3.4. Sics wHiE

geTteTen(Italic)- forET 78T AT 3T 3Heh! Hee © UTeT | fotaT e dshd € | 319
3G foTq witdene I Ctrl + 1 o1 i ST HTHRA 2 |

uUntitled 1- LibreOffice Writer

Format Styles Table Ferm Tools Window Help

o I by ! 7 A
na kb k- M /4 abﬁﬂ ﬁ'@u__ vo = 'Q' e = = G
A

. A\q’&ﬁ Lohit Devanagari ~ | 14pt v~ B JK g'% Ag A' M

Italic (Ctrl+1)

Ui

p

2

RT A [ a fern 1

o= 3.5. st wHTE

3T ATSA(Under Line)- 3119 378 I I15aT oh! @itshd HY T Tehd 8 | 38 foTg
STThT ITSTATE ShT SUANT AT JNIT | AT =T 3.6 & AT 9§ HSTATS HET
G Gohd & I h1-a1S T “Tiieehe I Ctrl + U T I T Tohd & |

Untitled 1 - Libre¢
Format Styles Table Form Tools Window Help
=, Ee=s) o
= Q) ke & k- & @ 2 % 1 EL-E i Al o=

- Ay Ay ~ | 1apt |~ | B IU;% Al

underline (Ctrl+u)

w i

<P = IS e feaT 2

o= 3.6. It AT FHIE

ragc | <«




¥ZTgeh o (Strike Through)- foreT 7eq st forell aTeRT o ket g3 fow@ & fog
3T T3 21 T START L Hohdl © |

es Table Form Tools Window Help

sk 8 - 2% 1 E-mliA =E-Q- o
Lohit Devanagari ~ | 14pt ~ B I U-5 A‘e. A A A
L3
A EeE 9w R gl

for 3.7. w15 g S

as fepte (Sub Script)-%ﬁ%ﬁmaﬁww%mﬁﬁ 3R BT ek
T v fre waardar 8 | S8 19en! fore T 81 O, ar fa@= T 2 log, |

Rotate or Flip

cccccc

o 3.8. wa fore wuie
T 3H YMdehe I (key) & GRT T T Tohd & | T8 ATIRT {51 S1eaT 1 G

Rkt T & 3¢ Toiae STl 38 o1E Shift + Ctrl + B =4 |

g st (Super Script)- foreT 78T T ol Teq o AT HUT AT AR BIST Hleh
foTEmT gt Rsrte Freatm @ | 38180 o 30°, X 3Tle | I8 “Niiéshe i (key)
a7 Y TR ST Trehat 2 | 191 TTe] ol Haihte AT 8, 378 "aide hidl | SHeh o1S
Shift + Ctrl + P gaITdi |

rage | zJ




T A (Text Case)- I8 Had: IS forad T7 1T AT & Hifh SIS
FUTHTAT § Teh & 378 oh! e o feTu 2t afieh B €, BIT I0MHTeT (abed) ST S
UMHTAT(ABCD) | SHUSHT SATeHTUT oh STTHIL STef Tohell ST ol fefiam STt & gge
0} SrgT foRT STl © | ST TRy 00 &1 ST & Al STt A1 3l qeedl &R oS0
foraT ST 2 | 36l TR S SR g AT BidT @ foh w5 SIS wrsal o avlt
U 1 BT ol 3 F I ST | I8 Gl il Sohee he | fhT ST € |

t Formak Styles Table Form Tools Window Help

{ Text > | Bold ;
Spacing > Icalic
Align Texkt > Single Underline ;_
Clone Formakting [ Double underline
Clear Direct Formatting strikethrough
Character... [ Overline
Paragraph... Superscripkt
Lisks > Subscript
Bullets and Numbering... sShadow
Page Style... [ Outline Fonkt Effect
Title Page... Increase Size
Decrease Size
Columns... UPFPERCASE ~
waktermark... lowercase
| Cycle Case
Image > Sentence case
Text Box and Shape > Capitalize Every Word
Frame and Objeckt > LOGGLE cASE

= 3.9. e kT
TSl TEET S TohT o fofehed BH ol @ | B9 STUHT ST o SATHI g1

T L Tohd & | Sk ITE0T HHfoTRad 8-

T T (Upper Case)- ARUN IS A GOOD BOY
AT HH (Lower Case)- arun is a good boy
et oW (Toggle Case)- Arun Is A Good Boy

ToH & (Sentance Case)- Arunis a good boy. He loves to play games.
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WT=¢ T 1T (Font Color)

el 3781 T e Rl TT A4 o TAT Bive Shott AT ITANT fomam SITar @ | 319
Frar fou 7Tu o= 9 31ea Rl Gcdere L I9eRT TT S&d ohd 2 |

Format Styles Table Form Tools Window Help
& i e o
Bl s Bk-5 &- 2% 1 E-BdiA =

v % &g Arial;sans-serif

Font Color

[7]Automatic

standard

el T (7RI <9 8| CTTTTT

[ 1]
II‘IIIIII

Recent

© custom Color...

== 3.10. B¢ FeX

glgise (Highlighter)

foreft amerr o orelt wTee ot ATET © feETT =TRd €t 6o foT T 39
BISTATSE L Tl ¢ |

Format Styles Table Form Tools Window Help

rel

= B-5 & 2% 5-BlA =50 Audgl | P™

v %&5 Liberation Serif viupt v Bl uv% AZAZ A_ A. . Bl=E=E=E =
Character Highlighting Color
[/INoFill

standard v

WWW%@T%I [TTTTT]

\ INNENNEER

B

Recent

© Custom Color...

= 3.11. ERAEX

Page | 27




T UATSAHE (Text Alignment)

e ToTsl TSt | Uoh I8 9@ T8 i & o1 UST 3hal STl © | $6 UST IX 3T ol
T ITGT ol hal [TEHT 7, I8 TATSTHE | HETHd ST © | T UsT W aTs (Right),
a8 (Left), 7&4 (Center) H, IT Teh B H GO DI e I1SAT Rl el L forelT ST
AT e |

L3
Left Alignment:
File Edit View Insert Format Styles Table Form Tools Window Help
H-E-% Imy B- 5 & 2% 1 5-BlA =50 AU g §powes Sé-4
Default Paragraphstyl %Al! Artalsansserif v oupt v B ! £ LA ,ﬂ A EEEEE-E g EE

AlignLeft (Ctrl+L)

R 4T Sl 3R 5 e 1 ¥ 21 T &5t o8 ¥ e 9
13 3R g TR R ) R e e 417 4 &) R T 7 TR U
3R ST TR <41 31 T U 2l

o= 3.12. Twe TaTEHE

UST O F1ea] ohl 1S SR O foftg o foTu 31T Left Align ST Hehd 8 | 3117 hl-aS
idehe Ctrl + L T ofi ST ol Hehd ¢ |

Right Alignment:

Flle Edit View Insert Format Styles Table Form Tools window Help
Db D0E S0E 5 e G%15 048

Default ParagraphStyl A el sans-serl | Mpt v
b ¥

e o e 3% 7 T 1 R 1 T et o o ) ]
73139 3 o ¥ R 0 ) 9 R e < 21 R o i v
3R T e < 1 W g

== 3.13. g tATEaHe

UST U T84T ohT €18 AR I Tofte o oI 319 Right Align FEHRd & | 3T FI-E
3itéahe Ctrl + R 3T off T L Wb & |
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Center Alignment:

Tepfaa 3R farmera & qff 81 T8 &l & fRwTe & et way
aaéslsfhmwmiﬂ:}?ﬁ aig%méﬂ?m\?mﬁwz@uqeﬁ%
R FTTeT TSR 397 T TRy U &

3.4, 8 (center) TATEAHS

UST WX Y1ecT ol Heg H fofgs o foTq 3119 Center Align & @ehd & | 3119 Shi-aiS
TieaRe Ctrl + E T+t SRIT h Hehdl © |

Justify Alignment:

B
IR fafasr Sl ofik agg favrsaa &t
21 U8 &F%d & fEE | HIadi da g9
WQawwwma@—cﬁmﬁﬁw
29 Bl AR 9RT &1 qE uelt 8, ok Fe
TSR QA HT IERT ugl 8l

= 3.15. SRewE TaETHe

SIFIHE H STG o 3T HTISIH h! THHT (set) hlsh SIRIHS h JATeheh o =T S
& fau Justify alignaﬂmﬁ!ﬁm‘_ﬂw% | AT HI-aAE ‘TR h” Ctrl + J T
off SRINT S Hohdl © |

foree (List)

foreft SRR <l el s o foTe foree ot STRiTT s &kl € |
et a1 ST AT Bl ©-

1. T SRATTE E=(Unordered List)
2. W@(Ordered List)
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'ﬁ??:h‘H'IT\-lDTI'cT Flc\%ﬁ(Unordered List): SId Hjﬁ | ch\lé S &1 BT SR ST &t
Tt futfa 7= 2t ® @ 89 unordered foT&e T ST o Wehd B | 39 &H
eI, TR 3TfE T =5 L fofee ST Hehdl # |

View Insert Format Styles Table Form Tools Window Help
- lm B-5 a2 AB1E-ZHA =50 - AUkl Qo /o4
wagraphstyl v AgAl! Arialsans serif v wpt v B g.% I ,d Av SEEEEEE-R E =

A fafir gt 3R Wy R 1 4 & T

. %W%Mﬁmmwaﬂ ]%PHFR'ER Solid small circular bullets "
S EERCIEEIRIE N —

. mwﬁmq%ﬁ% = More Bullets...

+ ST R 4 1 T g 2

o 3.16. T SHHTTTE =

AT Gei(Ordered List): ST Tt 7 315 560 & TR 1T 1 €& Heiid
Bl ¥ 1 89 ordered fofee o7 SUIT o ¥ehd © | SHH BF HE&A1(1,2.3...),

A& (a,b,c..., A,B,C,D,.....) T I T {AC T Hhd 2 |

Insert Format Styles Table Form Tools Window Help

-iml -5 62 -0%YZ-2i A =2.0- AUG gy BRowes /¢4
wy v R Ay sbma v ot v BIU-S KA AAV-EEEEEEF e EE
1 !

1 T o ol o g o 4 o 8 .
2 T T 5 R 4 9 R 120 ﬁwwwm
30 A T 24 4— b3
3 T AT E
1. T R < &1 TR

EMore Numbering.

forr 3.17. shATTa E=h

Page | 30




'é%"cf(lndent)
UST 076G e § J[E ST I8 T i o foTg 89 3 o ST &id & |

Insert e Form Tools Window Help
cllmg -5 &- 2% 1 BE-BdA =5-0- 44
hsty ~ Ag At adtsanssenf v 16t v BIU-5 AA AA- /. SE=S=SE E.E.F e 5042

1. A R SRl o Ty foRmera 9 9 8l

2. ¢ &9t % fouTe § Tl 9aw 99T 291 R Ry 'R
R SR GG SO AT el 29 &1

3. AR ARA 1 I o) &

4, ST TR 39 1 g Uy B

= 3.18.32¢

322 I o foIT 31y o # fou T sTe W foreteh ot Hehd € | W8 & o2 o foe
oft STt e T foreTer T Hhd © |

FITS’-'-[?ﬁﬁJFT (Line Spacing)

Y Uferal o e fora-t SiTe 21, I T wfd @ fraffa forar Smasrar 2 |

(8668 on %15 BANEE 0 AHA4ETS :
B wiolsansserit v et v BIU-5 AN A A FEESE R g EEES
oy
wﬁ@wmmmaﬂmmmmmmgwmm
e e ] mﬂiﬁwwagmma@wmﬁwéﬂ%\ -
AR ke 1 ey U R el EIRDREE respicns
fer 3.19. T dige it wrg wET

fou e fot T wep T it Wi g Tend © | TR Et W Y &1 utge @ R
SITC 1 I8 % 39 TohR (<@ |
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i Shles Table Form Tools Windaw Help

| EBB- 5 &- 2% H-BdiA =E-0- AUd ke §oaes S48

As wiotsansserif v wx v BIU-5 AAAAF.EEESET-E-F E-E
e R G SR 6 e 1 4 &1 9 S & 8 ‘f
Lo N

I R 9T 29 3R i R R 1 ) e e aren 2 oo

B R a1 ¥ geht & S eI 4 @l e vy

= 3.20. 21 diEe i AT WiE

U 1T (Paragraph Spacing)

31 UfRAT o STATET &1 SUTE o Hed fohdHT SETE B, I8 UUUTE ST 9
frifa P ST gehaT 2 |

Styles Table Form Tools Window Help

E- b e m QBT 5 MAN S50 dud i § o /4.
| Aalsansserf v v BIU-5 MM AA-S EESSEEE.F e E“”i
e o vgpoat aife o e 1 ot 1 75 dw o o
T ) ] 49 Y e e R ) e e S e 3 3
IR 76 &1 12 08l & STl R <1 91 T vy 2|

e foffer Sfeapon A g e 1 o 1 78 dh & R ¥
mmﬁwé&mﬁ?ﬁamw R e ST e o 81
R e &1 i v & 9 R < S ug 2

o 3.21. Yo wfem
3T §AT UTUTH TH-

k% 9 -5 o A &-Q- ~ ¢ /
BIU-5 AAAA -7 - BSEE F-F-0F srer 1=.0012

Rt fafas el aik T favme 6 qfy 81 78 dawer & fewma &
et WA 497 297 3R fay TR HaY 3fee JmaTet arer 29 B
AR e o1 N et & aret SR e 1 /1 agl R

e fafis wegpfadl ailk wyg v 61 9fiy 81 a8 dawe & e |
AT Ha a7 291 AR fyw IR UR GERT T A rard arer A & 69R
R 1 et uaft & e ergR A @ ey uy

o 3.22. 9QT g1 TUTE W E
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UST T3 (Page Style)

foreY 9T a1 T, 3TTeRT, HIfSH, 9T Sht ST, US Wied 9 Hutfa foman
ST & | O w215, TotsiT 3ifone Trget # witie 3y o1 € fewd 7 | 31w A= few g
el % STTER 38 Open T & & |

File Edit Wiew Insert Formakt Styles Table Form Tools wWine
Texk >
= - - [ ~ f )
{ Spacing >
Default Paragraph Styl + Align Text > ~
Clone Formatting
Clear Direct Formatkting “erl+m
Character...
Paragraph...
Lists el
Bullets and Numbering...
Page Style__. IS
Tiktle Page...
Columns...
watermark...
Image >
Texk Box and Shape >
Frame and Object >
Anchor >
wrap >
Arrange >
Rotate or Flip >
Group >
.
ferer 3.23. U1 WA FATS
IS WIEd O TF 3 YK fe@Ts
p 3
Page Style: Default Page Style x
Organizer Page Area Transparency Header Footer Borders Columns Footnote
Paper Format K
Format: A4 “
Width: 21.00cm —
Height: 29.70cm —
Orientation: @ Portrait
Landscape Paper tray: [From printer settings] ~
Margins Layout Settings
Left: 2.00cm -+ Page layout: Right and left ~
Right: 2.00cm — + Page numbers: 1,23, ... ~
Top: 2.00cm -+
Bottom: 2.00cm I Use page line-spacing
Gutter position: | Left ~
Gutter: 0.00cm +
Gutter onright side of page
Background covers margins
Help Reset Apply Cancel oK

= 3.24. 09 wEA e
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U (Page)

39 3T H 319 UST T BIHE S1T H=Y © I Gohdl & AT T SAwlTS ST ASTS TSt
L UST ST Hehd & | UST okl Toh <A © STel 8 36 STeRHE ohl TSt o Az 4 fije

{1 Al IS8 SRR T UST =T 8, 3 &1 &1 | fife 9Te 8 e |

FD TS U WSS - ThI & -
A4- 21 x29.7 cm
AS- 14.8 x 21 cm
A3- 29.7x 42 cm

Letter- 21.6x27.9cm

Legal- 22x36cm

U U (Page Orientation)
ST ST & T o B &-

. oie&hY MUY (Landscape Orientation)
II. ‘Jﬁ?f s (Portrait Orientation)
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AT AT & T Tide AU dead |

Paper Format

Format: A4 ~
width: 21.00cm -+
Height: 29.70cm -+

Orientation: | @ Portrait
Landscape

Paper tray: [From printer setthags] ~

== 3.26. ‘ﬁé‘d’ (Portrait Orientation)

Paper Format

Format: Ad v

Width: 29.70em - D
Height: 21.00m - 4+

Orientation: | Portrait
0 kandscape

Paper tray: [From printer settings] v

e 3.27. flewhd (Landscape Orientation)
UST | (Page Margin)

Teh U o fehae &1 | ot ST &enar 8 98 U aifsiy @ fuifia gar g | 5=
Y I fERImeTt § o IT SATST T Tohd & | AT TRt Teh HTSI9 o ¥ IT SIATST BH
F I A A T A g R 2 |

Margins
Left: 1.00cm -
Right: 1.90cm - | +
Top: 2.00cm - +
Bottom: 2.00cm -+
Gutter: 0.00 cm +

ICERMERSEIISE]




Ut Ui (Page Area)

U T | 3719 UST o ShTeg | ahts | T, Ufete, Toe=r 37k fo € gehd
& | U T 7 & 3179 O TR SRl HITET SGeTE < okl < |

Pattern

Reset Apply Cance

TS AR %<t (Header and Footer)

Torelt STeRHE H Teieh UST oh HUR shi ST IR 31T b 25 3ree, Tort Srora
G foTeHT =T € df 31T 8T (Header) o7 S9N T Hehd 8 | T&T 1 3R
JATYHT U o =t <t 3T FHEAT B al W%(Footer)WWﬁ | ST HX
T STANT ek OS] o off fore wedt & | Tefst ST Tget 7 31719 3t 3N Bt
T HTTTIRAT STTHT ST Hohel @ |

UST a1 (Page Border)

foTst ST g T o119 Torelt off UST o TR 3T Ueh T (EHT) 1 Hmior 3t
Hehd & | AT STAT-IAT S1SL ETEA, SIS ATEH I 7 6T ol AT L HeAd @ |
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Page Style: Default Page Style X
Organizer Page Area Transparency Header Footer Borders Columns Footnote
Line Arrangement Padding
Presets: | Left: 0.05cm  —  +
User-defined: Right: 0.0s5cm  —  +
Top: 0.05cm — +
Bottom:  0.05cm — +
synchronize L3
Line Shadow Style
Style: —_— ~ Position: D | ] i
Color: I Black ~ [ ]
width: Hairline (0.05pk) ~
Help Reset Apply Cancel OK

e 3.30. g STET

UST SRTeTH (Page Column)

UST it <hl HERIAT ¥ 3ATT Ueh &1 UST o T L 378 JAH &9 ¥ foTg gehd
2 | S 3T Ueh 21 U 9T i T ST o foTeT =Ted & i 3119 UST shictd shi Hae

TGS ST Ehd 2 |

Most ancient Indian texts
contain religious themes and
these are known as WVedas.
They are assigned to c. 1500—
500 B.C. The Vedas are four in

of the Jainas and Buddhists
refer to historical persons and
incidents connected with their
respective religions. The
earliest Buddhist texts were

written by Panini, which is
dated by scholars to around
700 B.C. The works of
Kalidasa who lived during the
Gupta period comprise poems

number. The Rig Veda mainly written in Pali. They are called and dramas. The famous
consists of prayers. The other Tripitakas (three baskets) viz. among them are
three, Sama, Yajur and Suttapittaka, Vinayapitaka and Abhijananashakuntalam,

Atharva-contain prayers, Abhidhammapitaka. Of the Ritusamhara and Meghadutam.
rituals, magic and most important non religious Besides being great creative
mythological stories. The Buddhist literature are the compositions, they provide us
Upanishads contain Jatakas. They contain the with glimpses of the social and
philosophical discussion on stories of the previous birth of cultural life of the Guptas. For

atma and pramatma. They are

the Buddha. It was believed

the history of Kashmir we have

also referred to as Vedanta. that before he was actually an important book called
The two epics, Ramayana and born as Gautama, the Buddha Rajataranagini written by
Mahabharata, seem to have passed through owver 550 births. Kalhana ( 12th AD)
been finally compiled by Each birth story is called a Biographies or charitias are
c.AD. 400. Of the two, the Jataka. These stories throw wvery important non-religious
Mahabharata is attributed to inwvaluable light on the social texts for writing history. They
sage Vyasa. It originally and economic conditions of the were written by court poets in

consisted of 8800 verses and
was called Jaya gita or a song
dealing with wictory. These
later got expanded to 24,000
verses and came to be known
as Bharata because it contained
the stories of the descendents
of ome of the earliest Vedic
tribes called Bharata. A further
expanded wversion of 1,00,000

pericd between the fifth and
second centuries BC The Jaina
texts were written in Prakrit
and were eventually compiled
in sixth century AD at Vallabhi
in Gujarat. They are called
Angas and contain the
philosophical concepts of the
Jainas.

This category of literature does

praise of their patron rulers. As
there is a tendency among
them to exaggerate the
achievements of the patrons
they have to be studied with
caution. One such important
text is Harshacharita, written
by Banabhatta in praise of
Hmsﬂavmdham. The earliest
south Indian literature is called

Verses was named not have religion as its theme. Sangam literature. It was
Mahabharata. Similarly the To this class belongs the written in Tamil and is secular
Ramavana of Valmiki Dharmashastras or the law- in nature. It was produced bv

== 3.31. 99 *iew




Page Style: Default Page Style >

organizer Page Area Transparency Header Footer Borders columns Footnote

Settings

Columns: 3 -

n
1S

width and Spacing
Autowidth

Column: 1 2 3
width: 533cm — + 5.33cm — + 5.33cm — +
Spacing: 0.50cm — + 0.50cm — +

Separator Line

Style: None ~

Help Reset Apply cancel oK

= 3.32. 99 Fiaw foer

‘sﬁ'ﬂﬂj’&' @i T8¢ AT (Printing the Document)

Torelt STeRIHE TR T 3t o S8 319 36 U L Tohd 8, SIT HATT U] Harat
T € T 8, T s IR & fiie F T STavaehar gt ¢ | e w9 @ g
AT STRIEE T fifeT & AT | TS T IR & | I8 il o T &1 oacd
s HY H ¥ 32 s 0X fefcTeh i, T35 st o ToTT 3119 3Tk i (key) Ctrl +
p T+t ST F HHA B |

File Edit Vview Insert Format Styles Table Form Tools Window Help

BB K- 2 9 E-madi A HE-C

New
open... |

Open Remote... peration Serif ~ | 14pt - B IU-5 AA
Recent Documents > |

Close

Wizards >

Templates >
Hello world

Save

Save As...

Save Remote...

Save a Copy...

Save All

Export...

Export As >
Send >
Preview in Web Browser

Print Preview

Print... Cerl+P
Printer Settings...k

Properties...

Digital Signatures >
Exit LibreOffice

= 3.33. 99 fiie
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A=t fife A=y fomm mam 2-

210 mm (A4) General LibreOFfice Writer

Status: Default printer Properties...

Range and Copies

Pages:

297 mm

o= 3.34. fiie Tt

31T e © 37freh fiiet g ht feufer & fiiex oot == e gend @ | 3719 Uk 97 U
g 37feren TSie i i oft FohTet Tond 2 | 59k STTET 3719 UST <hl |1geT 371 STRESY
T HERd g |

» Formatting Toret STerpie o fafiTe wRTH W dTeeh o1 2T STThivd o Tehdl
2 3TN AEEqUl SIHFRT TSR S HehT 2 |

> TTHTH 1 HIHE F § AT THY STRIHE 1 T&EYT 98 ol ¢ |
>> o€ TGO U ANULIH o 31 fehed I HdT ©; vietehy 3T iee |

> 3T UST i THTERTTEA S o feTd 31T ST 3K O O WX aiTet 3R
ST SiTg TRl € |
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1. T IR forw.

HAETH

(a) TTfcTRad & & 19 A1 UST U T 3T ¢ |
a. TSEhYT (Landscape)
b. ISR (Subscript)
C. W (Superscript)

d. W (A4)

(@

(b) TG M o foTu fFfeTRaa STeaa 1 IUFHT foha STrar @

a. Je-TTEET

b. 3
C. ésrqm%
d. St

(¢c) Ctrl+BaH 3TN o e fmarsmar® |

a. 3efTeh (Italics)

b. %< (Font)
c. AeE (Bold)

d. 37T (Underline)
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(d) ISR §H SR ohl TivE ST HATHR ST ohl A ST 8 |
a. Format
b. Insert

c. View

d. Form

(¢) Word Processor GTFea?X ¥ |
a. System Software

b. An Operating T&eH
c. An application ATFea

d. A translating Program

2. FaferRae went & s forfau -




V. ST AR AT FA Sed 2 2

3. IR w1

[ HeH Yg 3T Teh 9€ HIEe ST |
[I. 399 Lion and the Mouse ! &gt &l fefaT |
[[l. ST I eRE o |1 & 8 H= | dies, 3efcieh, SSTars 3T Bive Fel
T ST L | FETHT I B o o1e 36 6l Al |

forerer o foru ST fYreter ST SIaTT U 7em | SR BT R AU
TIHISTT oh T & UST STTRURT ohl Yfereehet o qreay ¥ farenfor st gHemd 37K
STATT |
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TS MO W ATeooed AT i

B 4 Inserting Objects in Word Processor [

C52404

37} T B0 THET- IS TR I 91T (sentences) 3T WITH (paragraph) a1
BIHfET (formatting),ﬁ?r gfa (page setting) 3R Wﬁ?ﬁ (documents) |

ST ST (add border)

Libre Writer W objects T insert (STSAT) AT

IS IHEL T T H ST ST TE o6 STARIHH S ol STAIT T & | 36
Wﬁ%ﬁ‘éﬂ'@ﬁ%l‘l‘l‘fﬁﬁ'ﬂ, sﬁsr I IE 3¢ Word Processor ¥ ¥ insert
HL |
4.1. Teret ‘sﬁ'ﬂﬂﬁ?ﬁgﬁ'ﬁ (images) T STIEAT (insert ST

HTTEAT images Torell ot TgeT SoRpHe | ST ST Tohel! & | 3T PRI
fTen U ygct § Iutsy i Y SHST ot Shie ( insert) o foiq FReferiaa =mon =t
RINCEET

4.1.1. P THESH | save FHST SIS

Step-1 Insert II1 FL > Image
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Step-2 3 picture 3T TIT ohl [STE AT SISHT TTEd & 3T 3H W S fokeleh

T |

File Edit View Insert Format Styles Table Form Tools Win e
. T “ Page Break Ctrl+Return ‘ \ -
- I More Breaks 3 :

Default Paragrapl Image.
A
L Chart... L
Media >
Object »
Shape »

Section...

Text from File...

Frame style:
Preview
Insert

o 4.1 (a). Insert FHIE FT view o 4.2 (b). 39T 3972 (insert) FET

4.1.2. Picture I resize I IT move FHLAT

Step-1 fonelt picture &I resize FH T move FH o foTT, picture pl =IT
|

Step-2 corner handle 9T ST I " Hr 34@% i drag (@ﬁﬁ) HL |

e 4.3. Picture %1 resize T
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4.2. QR Code ST&T (Insert an QR Code)
78 gl et ofst HTfee H o Iuciey 2 |

Step-1 Insert =Iq L > Objects> QR and Barcode

Untitled 1 - LibreOFfice Writer

File Edit View Insert Format Styles Table Form Tools Window Help

. . J  PageBreak Ctrl+Return | _ al R . e A
@ More Breaks > q U 15 ol
| Default Paragrap . || 12 pt v | B I U-
N Chart... S SRR R RN
Media >
Object > Formula Object...  Ctrl+Alt+=
Shape > QR and Barcode... S
Section... OLE Object...
Text from File... [

o 4.4. Insert & QR and Barcode

Step-2 3T foFEt AeTETs T foieh AT IS SR 30 forg Tahd @ |

QR and Barcode

Options
URL/Text: ‘ Hello Prashant
Error correction: @) Low

() Medium

) Quartile

() High

Margin: ‘1 -+ |

Help ‘ | Cancel | ‘ OK |

fo 4.5, Insert & QR and Barcode
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Step-3 FI-3TR HIE ATk SRHE H [ ST |

o 4.6. Insert & QR and Barcode

Step-4 31T forell it oY TR Th hl 7aQ U 38 Tl o Tkl © |

4.3. TS 3ﬁ'(fl;?? (Header and Footer) ST

TS IT TR BT & ST TRt I8 o 21 AT ST o o ST T o6
offr 5 1T € | 39 &7 3l TS HeT ST &, STefoh B fohel I8 o i<l T@T SIaT ¢ |
HTHAR T S &A1 T STAT SFRIHE ohl ST ST o 11T fohaT STt &, e
STRLHE T TH, ST 1 3N, I8 g, frmior ffer aife |

Step-1 Format Tab T {oFeTeh ShifsTg)

Lists

..........

|||||

o 4.7. Format 357 & Page Style o Header and Footer HHTS
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Step-2 Page Style T foreTeh shiferT |

Page Style: Default Page Style x

Organizer Page Area Transparency Header Footer Borders Columns Footnote

Header 8
Header on
Same content on left and right pages

Same content on first page

Left margin: 0.00cm +

Right margin: 0.00 cm +
Spacing: 0.50cm -+

Use dynamic spacing

Height: 0.50cm - +
& AutoFit height

More...

Help Reset Apply Cancel OK

o 4.8. Format 357 Page Style # Header and Footer 0TS

Step-3 I8 TS AT B AT (Style) T FSRTaRT T T AT AR & |

File Edit View Insert Format Styles Table Form Tools Window Help x
e i e TR = 2 = =
B-5-w- @ = [q B- & o 2% 9 fl-EdiAl ==5-Q- & s 6 Gd Boccass S @ 4

Header v %&‘5 Liberation Serif vitzpe v B ITU-5 A A A-2. EEEE E-E-R 976 [E-12

Styles X

® ¥R e E e K-

FrANe CUENts

,,,,,,,,,, ~ Header and Footer
Header (Default Page Style) ~

> Footer

1 Header Left

e m >

Header Right

\J

> Heading

> Index
List Contents
List Heading
Preformatted Text
Quotations

Sender

Signature
> Table Contents
» Text Body
Show previews
Hierarchical ~

 Page1of1 0 words, 0 characters Default Page Style English (India) I- PR © @ @ 5%

1 4.9. Format &5 4 Page Style T Header and Footer HTS t\{;l-\i % e

Step-4 To delete Header or Footer, format T‘a\lﬁ >page style> Header or

Footer %\ﬁ > Remove Header %\ﬁ YT Remove Footer ?ﬁ |
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e fig

% oTsr TR (Libre Writer) TT9ah! o, SieiTe o, 3TEa, TR 31K
TTEIATE Se (Insert)ﬁ{lﬁmTWW%l

t= ToTsy et et ot 7 ST wTeel (resize) STa ohl GferdIT J&T LAl
T |

% T8l T2et 3 HTEH & 3719 QR IS 7 T & |

= TSt Tget o HTeAw | SfRHe H 98X d Fel SIS ST 6o & |

1*— THTEIATE T ITAT ideas 3TN information ! FPFﬁ?I'I?f, T 34'&'@[, Flc'\%l?ﬁ
e o &9 7 Fafra s & foram s osrar € |

T hT
1. T SR

1. I MEE | o Sire- o foru Sue femar sirar 2 |

a) Table b) Reference
c) ClipArt d) Insert

2. 3" & document H TSI EYT ¢ |
ELE b) TS 3T

¢) TRl d) ITI<h T+t

Page | 48




3. 38 9 THIEATS UTftheh A2l 2 |

a) List b) Process

c¢) Pyramid d) WordArt

4. Tereft 3TTaRfcr o1 &1 Sget o e fashed 2 |

a) Shape Fill ~ b) Shape outline
c) Shape Effect d) Align text

2. fFraferRaa wart o st it

i. B9 $eIE T 3T image i U IS SRHE H ¥ GFATTT L Fehd
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iv. SIRHE H 88T Bl a1 SIS SI1d @ 2

3. AR w1
i. T STagHE $Ig SHTE T 38H 30 TRER o s | @l s fafae |
ii. Toh SRMHE HIEA ST, I8H O TEe 6T HS SIS Ud Bl H US| HeA
TefRid i |
forereh fdor: freren forenfiiat i o v < fafirm wFaie w1 stvamg e |
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THSI T TRET %‘%E—I&i
Introduction to Presentation =]

C52405

TSIEIM (Presentation) STTTERd! hl 3T 12T 37 SR ohl TATSS o
Y H dIR R IR IR hH § Heg AT 2, ST {9 shl TI5dT ohl JIeTdT © |
|1 &1 STET H Teh 939 Tae] SISl & ST g4 SATEeh STTehteh 3T TEdd hi J1 STl

gl

IRERGIETIR S (Libre Impress) HeAd: Teh UTTherd ISIe B9 UfteAahy™
T S fetst TR gRT ST fotst sheeh, foTsh Tge o ToT WitedaR Uohel | 3TTaT € |

I\ o~ N

S.1. i?’l&—sl-;IH (Libre Impress) Y IE SN

O

Step 1- TR H= W foreteh shifote>Torst see forshed =14 |

eo@B@EoB
o 5.1. forst 30w = forared
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Step 2- Impress T foeteh Shifore, ThT 95 wiger TR IS |

ssssss

e )

Click to add Title +

©

Click to add Text “Layouts

o 5.2. T 3999 5 wIed &1 ITEY
o

5.2. ToTsl-300g B ShiA (Libre Impress Home Screen)

Title Bar

Menu Bar [—=

= . S " «—— Ribbon

Click to add Title ¢

Click to add Text

o 5.3. foTsl-30o g whie

1. 21geT & (Title Bar): I8 TG W gy S 9T 2rar & forem Impress
Presentation 1@ BIAT 8 | I 5ol deh 1@ WIT ST ek 3ATT SHH IS B

SR 39 O T2 T 0 @ | O hH o o1 1Y S A9 B3 bl {7 @ o
foaTs 23 & |
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2. U= S (Menu Bar): g AT 2[5 SR o 3leh A< &A1 & | $6H ST~ ST
ST o S U STTd & TSTeRT AT SUANT ileh Ieh ATH oh STTER HIH L ohd
=l

3. Ribbon: SI&T 379 foreft st Menu S Home, Insert, Design $<'€4llr<\: I foreem
A & Al 36k 18 SIT 3ATIh | Menu FAdT & 38 &l Ribbon Menu F&d ¢ |

5.3, g T3S o o [oTU (Creating a New Slide)

Impress H T AT TIS9E J[& Hid WY, AT FFIL Th 75 T&IId (Blank
Presentation) 3 HTeF Y& AT AT |

Step 1- e 8T FIST ool T =T hITSIT |
Step 2- faiet o 918 3T New T*:lﬁ, 9T Presentation 9 foreteh hifSTT |

i Edit View Insert Format Slide SlideShow Tools window Help

New > | Text Documen k :7 .

open... Spreadsheet

Open Remote... Presen tation

Recent Documen ts > Drawing K

Clos Formul:

Wizards > . HTML Documen t

Templates > XML Form Documen t e
Label:
Business Card

S Master Documen t ( to

Save As... Templat

Save Remote...

Save a Copy.

Export...

Export A >

Send » .

Preview in Web Browser CIICk to

Print

Printer Settings...

Properties...

Digital Signatures >

Exit LibreOffice

eIl 5.4. WIS ¢ Rl ==
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5.4, THL SIS o fou (Inserting Text)
Step 1- HL TR IS (Designated text placeholder) ¥ foretap FIfSTT |

iew Inser ormat sl lide she
] 8- Im = s a = i A
B = 7 Y- 3
pppppppp -
.........
nnnnnnnnnnnnn aapt =)
i X B I u-35 A x| %
Click to add Title,, ‘ N s , =
List: ]
.........
=
.
|
Click to add Text & oooen = oooem
00 cm £ o000
= ¥ o00cm
.....
Line
ssssss
re
nnnnnnn

1 5.5. Impress T New Presentation 3T AE)

Step 2- Teh S S8 3T dR WiHRIee! W fofeteh hid 8, T 98 Tfsha &1 SraT
2 3T UL (Cursor) ST AT & Toh STTIhT YT i R Fal

File Edit view Insert Form, lide sli
B-E-8 0@ - 8 k % -3 B-m@da AQ-a L4
* £-/me|—-Y - = = =
Slides < propertles x =
! -
a =
\—/ B I U-5 A x
I a A #a o n
@
== = = &

Click to add Text

1 5.6. Impress ® Text placeholder 3T 9

Step 3- HTET T foh STIHRT e TR THERITEL o e fEord 7 37K

HOAT SR 2T HTAT L& I |
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File Edit View Insert Format Slide SlideShow Tools Window Help
(=R R T ] B8 &- % HE-EB ST E-a@dAQ-A LEE-E
X - /Mo —-W-L--0-»-E-B-%-B- FE-F-ji-m 5
slides - Properties x
Character
i
Liberation Sans v 44pt =
‘ B I U-vsS A Pk
Hello World A PR—
+
Li (/]
graph
2 & & = ]
. Spacing Indert:
Click to add Text e
& 000 + = o000
T 000 + = 000
¥ 0.00

5.7, Text placeholder e} FAES] Toram TIT text
5.5. ¥AT5S insert h{dl

SERREIN] ﬁ'sc :I'sc presentation RIS T %, ar 399 3k SNUES AL (Title
slide layout) % GTY Ush T3S BT | 31T fafr=T wehR o @emse @ frat =
3t T3S Eitgfeld o gehd € |

Step 1- T3S ¢ § = 158 W focieh T | A9 Ctrl + M & off 718
EATEE SIS Tohd ¢ |

File Edit Vview Insert Format Slide slideshow Tools window Help

=~ - e r= Newslide N wkM ] = . @
. Duplicate Slide
% -— £ /W insertslidefromFile... -8 %
slid Layout >

1 Helo Wosd
1 Set Background Image... |
Slide Properties...
Change Slide Master... I I
New Master 4 e 0
v Master Background

Master Objects
Master Elements...

<

Hideslide
Rename Slide...
hp:
Jump to Last Edited Slide ;lICk tO
Move 14
Navigate >

summary Slide

slide Transition

1 5.8. Impress ¥ Slide tab hl T
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Step 2 - 715 wA1ES fo@rs <t | forelt +ff weieioet W forerers Shifste it 2ere
ST o fAIT 2159 T I ShINTT | AT 377 T shl Tl S
ferst 31 =Te, Shie o foTu oft 31TseRe O foretoh S Tohd € |

slides x Properties =
v slide
1 o e
Format: | Screen 16:9 ~ =
Orientation: | Landscape ~ A,
1 1 Background: | None ~ =
: Click to add Title ’ 3
Insert Image...
@
: Master Slide: | Default ~
L]
Click to add Text T
8 Master Objects 3
Master View
=

ﬁ ﬂﬂﬂ ~ Layouts

=
- IS Gy | S | | S| N S|
e [

Insert Image

Slide 2 of 2 Default 1 1350/8.89 000x000 (o English (India) + 9 @

o 5.9. Impress T TAES T oY

Step 3 - TorET HISET EATEE AT AHTIE ST o (A, AHTSE FHHTS T fefeteh
SIS, T Srifesd 3se =i |

Properties X =
v Slide
3 =
Format: | Screen 16:9 v bt
Orientation: | Landscape ~ As
Background: | None =
g ~ =
Insertimage...
L
Master Slide: | Default v
Master Background
Master Objects
Master View
e,

~ Layouts

= 5.10. Impress T AT hHTS T g
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5.6. TATSE ohl SATTRd AT (Organizing slides)

T TRICTH | SATTehT SATTIRATIIR 5 TASS & Tehell & | ThIF o a1 AT
TATES A U9t (Navigation panel) 3TTIeh! TATSS ohi AT HLAT STET
SATAT © | 81§ 31T AT &I H SAT5SH hl Sitetene, THedaeard 37T 8T Hehd
g |

Slides

Click to add Title

T [
0y A

o 5.11. Impress | Navigation panel shl G

a) WW (Duplicate slide): Ifq o fordt TorTgs i fterar @ s
T UL AT ATE &, Al STT IHhT FiecTohe T Fhdl & | TATTS ohl SitcTohe
ST o [T, 36 TATSS ST =TI hITSTE S 3T gficTohe T =ITed &, HISH
X Trge-fereteh ShIfSIT ST fo@iTs o ot 5 ¥ “gftctehe TeA1ge” = | 119 %

TSN oh! T8 TehL Ueh |1 3Teh! gltctone ¥t T T & |
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3
“ Cut
Copy
Paste

Newslide
Duplicate Slide
Rename Slide...
Hide slide

Delete slide
Layout

Navigate

Move

Slide Properties...

fo 5.12. Impress H ZitcTohe TATES H=Y AT 3T

TATSE 22TU: If 3T 39T presentation & h1E TATES BHT =T8d 8, T 31T
U BT Uohd © | 59 39 TATSS oh1 I hiTSIU 59 319 8HT T8d &, T
H shi-ae W feetie A1 siehedd it ge |

5.7. TATZE bl hid] T UL HET

i 3T Teh B ASTISE o WY s T3S ST 9T=d 2, dl Aok folu @redl Trge
 IEAT FLA o ST T8 § 15 7T TAT3S i hidl HIT U FHEAT 6 8

ghdre |

Step 1- TATES ATIH U7t H 3H TATSE T T shifSTT fS 2719 SRt aheT
TEd 8, T 819 39 T i) e WX fareten ShINTT | Sehfcuss &9 4,
39 379 FI-a1E T Ctrl + C ST Foh @ |

o 5.13. Impress q EATESH ok selection
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Step 2- ¥13€ Navigation panel 0, 0 (paste) €19 ir:ﬁ o foTT =g &
3w = & q TATZS! h o) fFeTeh ShITNTT | W horizontal
insertion %l—gr fe@E o |

Step 3- 819 38 W UL IS W forerers ifSTT | Jenfodss &9 @, 3119 19 -
TMEWCtrl + VST TR B |

Step 4- TATES AT LI W fe@rg it |

5.8. TSI (Presentation) COR:E (Save) shIAT

ST ot 31T g FAT TS & LA @ AT el HIS[ET TiSiae § Seeltd hid & al
HOAT TSISTM 89 HTAT Heed QUi & | STea SN S-S 89 A 8 3Tk I i T8
(lost) B T STTAT SIT Hehal & | 3TTYhT 39 &1 IX +ft €21 A1 1T o 319 Isiey ™
T el Ud LI & dlich 18 H 38 GISHT STHH & A |

Step 1- &7 W U9 FHHIS T UdqT TME TR IGHT T HINTT |

File Edit View Insert Format 5Slide

T ~F-e~ =M & &

Slides X
fort 5.14. foeh (Quick) THE® TSN H Hel HHTS

Step 2- Ife 3ATT HI3A bl Uil I T L I8 7, T Save As pane:lﬁﬁ'@'l’%i
l
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File Edit View Insert Format Slide

New >
Open...

Open Remote...

Recent Documen ts >
Clos

Wizard >
Templat >

Properties...
Digital Signatures >
Exit LibreOffice

<t 5.15. fasie (Quick) THE® ZASU H Save As panel

Step 3- TR STTHERT I8 T[T G ToF WIS hi hal Wl AT § 1 38 U BIse
ATH 7 2 | 379 P T 1§ T I o T 1SS (Browse) W

[ESEXAISI

Step 4- Save As Dialog ST fa@Tg M, 978 T <[ SET AT TSIIE 89
AT TR © |

Step 5- SR o6 fTT Wrser 719 &1 hIINTT, Tt Save W fareteh IS |

+ Other Lo
Encrypt with GPG key ODF Presentation (.odp)
th pas: d

e 5.16. Save As Dialog ST




Step 6- TSI U BT ST | YSIe hl N T THT 3T A9 TR
1 U (Save) A o foTu fhe & T swHiE W fofeteh L T ¢ |

V' NOTE: 39 379 h1-a1€ W Ctrl + S TR ol 69 FHHIS T U5
Tohd ¢ |

VAT ®EA HT A .odp (Open Document File Presentation)
TSI o 91 U T |

5.9. 's'rfl'{? i &g AT (Close Impress)

TSIeYE shl SFIRAT €Y U S TohIT SIHT I1RT | Ife 3AT9eh I shad Ueh

TS Gelt 8, T 3719 39 & L T § |
Step 1- B ¢ W foetah hifSiw | o ven mt_rorna_st
Step 2- ToeTah Exit LibreOffice. EE?DMM )
Ife AT Tad i o &1 presentation 3 ;mft i
g 7 foRar 8, @1 U dialog ST fa@s < p

fSrerst gt STe R R 31T siee e H uftad e

Save Remote...

T T AR B | AT 3T AU qRedT g soveecom

Save All

Export...

FETATE 2 dl Save R fFasw hifsw |afe sy 2000 :

Send »

Y UREdT e T T8 AEd & d Don’t  previewinwed srowser

Print...

Save WWW | aﬁ mgﬁma’aqﬁ Printer Settings...

Properties...

Digital Signatures »

Wﬂﬁ%%?ﬁ Cancel IT i‘al’ﬂch qa&Q | ~ ExitLibreOffice

—

[EERRVATESECE LR
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h Save Document?

CE Save changes to document “Untitled 1" before closing?

Your changes will be lost if you don't save them.

o1 5.18. dialog SR Rl 9

~~
S

P
-

-
~ -
~~~~~~~

TSRV WIEAT S AR A % Foru: Terd i wt foreren SR -
> Goft TUTRT O SITE -> YSIeR ETHea 1 foreqeh shifsru |
ATT I 1A W Ctrl + S TR o} HF FATE T 5 ol & |

Libre Impress, Libre Office ST ST foham 7T |

=+ &

3T SIS T Ctrl+M TR oft T3 TATEE SIS Tohd 2 |

{awqmsmﬁ]

INGER R

(a) BT U™ (b) TSIETH T
(c) ST T (d) I TEEX

2) ToTsl THT W TSI a1 o foTC UST Rl ShgT ATaT 2 |

(a) Sheet (b) Slide

(c) Paper (d) File

Page | 62




3) 93 TSI WIge TeiA o fou faemea 7 |

(a) New (b) Edit

(c) Layout (d) View

4) TSI WIS Rl Save i & T8 Trehed 2 |

(a) New (b) Edit
(c) Save As (d) Close
5) freferRaa & s i,
. Siee ot o § 2

I, TSIy &g ot i UTshaT RIT & 2

[ll.  USIE9T (Presentation) ST A (Save) ¥ fRATATATE 2




V. ToTsr 2ATTRe W Oiev™ ETFeaay st AT foTfiRau |

6. IR ShTA

o8 Ygol 37T Ueh YSieYH WIge SFT4 | 38k o1 379 fordt oft 21fver X 10

TATSE hl TSI J4TU 3T T hifT |

foreren & foru fcom: frereh S0t SATC MU ST # TSI &l ;® T,
TATSE hl ST, SHE hl SISAT, TATSS o T FHH AT, TSieI IS hl
YT T 3T TSI hi sic hAT TS hl Yicreehet o ATeaw © Tl s

T |
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SR

6 Scratch =

S Teh FH TRET- Tl ol JTEIAT, T8 $HH, Tshdl T HTH IH LT
3R ST ST |

Tohl T 1:3[edh TTHTTHT WTHT 37 SAHTS oeETse &, STl 3119 30 &
Sl g fed haTii, T 3T TN 597 ohd & | 59 Hell § 3T Thd o o=
SQiTeh oh ST H |G | STT3T 378 Toh-Tsh shich HIGHT I[& i

6.1. Thar W f4E9TieR (Coordinates in Scratch)

ﬁﬁﬁimageﬁ,mxﬁ'{yﬁoﬁ?OW%Wé@W%IaXEﬂT
y ThiIF o fgeries € | FHasTien Teamsti it Uah St & fSTeent 39T whia | foredt
T 200 ¥ 200 F A= 7 |
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19 BH x 3R y T HH (LR i &, 1 e (TI132) SHY YR AU
fearfa O aftad 0T | 3T73T 39 Ueh STEL0T o |1 =0T &F %Wé@:

Step-1 TR T, x 3T y o7 A (SHice T W 0 W T AT © | SHHT Hadd & b
ThIT W EATSE, Thi o 787 fig T e |

Step-2 ST& 89 x T A 100 3R y T A 0 FEaId &, dF TIES 100 e AT &t
T 4 =t St |

Step-3 S B x T A 100 T y &1 AH 50 SEeAd 7, a1 T3S &St €9 & Teh
&1 foig e Tt eifert 1 50 37k ST T 3 wrgell € |

IE IS G o 6.2, HefRia 2 |

WoScah S Join Serateh ~ Signin Join Seratch ~ Signin
' BLY
y LS R 1, ]iPis N 0 o

00
D
0F o N
)
(P
" Y
X=0y=0 x=100,y=0 %=100,y=50
Spe Spred " 1y o Soge Sprte St ax Mty oo Yy i Spret e o fyo® "
Sor O om0 9 0 W D M o " Y

= 6.2. T # TcTion o1 3eTETT
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6.2. Sa'c’ sATeh (Event Block)

Event (92AT) 98 € ST 91¢d Bidl § 3T N €I ATh{Yd Fid! ¢ |
e | foret ot 3aie ot 2 i o fIT @s@ 98t Events TX foreteh ot |

@EEB oo B -

Ccocde ‘l Costumes o» Sounds

Events

<
-

-
0
0

=

5 ‘
!

-
0
=
"

1)
Q
=

10

o 6.3. Sha H e A
39k ZT Events T foreteh 3t o o1, forfare fawt o | we fofet Oet gern
2 | T UeT | fe@me Tu wedreh feT o foT T STemT-31enT 3ae e st Hehd & | SeTet
o 1T
Step-1 Events T foreTen i ST 98aT faehed “When green flag clicked” T—a\lﬁ 3R
ot 38 Tohee & | g ot |
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Step-2 Looks 9T fofeTeh T & oTg, “Say Hello” E\Iﬁ 3R 30 ueed! fispee It
“When green flag clicked” %:ﬂﬁéﬁﬁ |

- Qoangs v Prev Jeae W Titoals JonSeratth  Sgnle

& Ceo J Costan @) Sante '

e @

o

® o e e ie |

: © °
Slo 8

ooty ey

00

== 6.4. a1 T FT 3R

Step-3 T fehte &1 & ST T4 FiH W @y U & 3 W foete i |
Step-4 TIEE “Hello” e ST ok ot 6.4 T fe@mr ma g |
Tt atg, 3119 foret oft fomam sht woher | few 7 fafir e WOe s ahd 2 |

forerer T Rierer STgEel e | Uferesher o wreaw & formmien o &g i
HAAT-HAAT 3¢ HHIS @ |
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6.3. AU 5Tk (Sensing Block)

& (Sensing) T 379 8 foIAT SIATY forell o h! HEH® AT A1 3T
AT | BT sciieh o7 SUANT i & [T Sensing W foreTes i | forcteh oA & 9118
TEshed (Scripts) STl AT Uet fo@TE 27T | shig oft REshte < ST hTH LT T
o | ST o6 fo1g -

Step-1 34T ﬁ:’q b LERSTH FE Y T ST TEd g, Sensing 9T \ENED ?m'si, ot ask what
is your name and wait %\Iﬁ 3R fpee & I g1 ol 3T A say hello Hel ™ & |

Step-2 8 AT FEhte &7 o HU 214 b 9T L 31 I foreden hi | TTgE Bl
T | TS THT TRT STTIERT 10 T & TR Ik ST STIHT AT ST oh fIg
Teh i foms < |

Step-3 ST H STUHT ATH W o YU h1-a1S T Enter Fsil (key) ST |

- [ : 00
== 6.5. Tha o Gt 1 SeET

319 fafST =T Sensing FHTS T 1 ol TR Thel W HTH A T 3THE o |

foreren TeoT- Rrereh SATsElel e § Sfdreehcd o Wrew © foanieial o g
faf¥=T sensing FHiE W H™ FETT |




6.4. chrc';lc'l sciTeh (Control Block)

il sateh (control block) I T & ST Tohd TS T TS T 7T ol
R o € | ITeRT START T S, s Teh HeaTed B o 3hH ol RIS et
3 F1a1 o TR T 0T o o fore feram sman 2 |

3 SciTeh T SUANT i o ToTT, T e ol Siieh o ST salieh i editor T T
FBIS |
§Toh HTHT-3THT FHeglcl YA (control statements) & | BH F Hacaqul
ST ah! FHRYITAT @ |

EBEB oo - P -

o’ R S «€»

1. Repeat—qgmﬁam
|

2. Forever- I8 39 sdieh H
St e e A A |
TR |

3. If...then- If 3 AT ST 914 &
% fog O W 9w F
AT | dastataes

4. If....then...else—SHWAFr B <%
fshte O, ST If scTeh o 37T A
Y& i TR 3T (condition) |
g Bt 2, d 3%k A1 (g
statement ﬁ“ﬁ%ﬁ %q =
GITQﬁ, E;Hﬁﬁﬂﬁﬁ SERIRCTCFERITG gﬁ?ﬁ%, arl else condition o d&d
statement TeaTiea for ST |

0:0 0

00/
¢

9
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5. Wait until- 9 Ohrd;lcfl scTeh O v\l)é statement?laﬁ?m"ﬁﬁqﬁ%ﬁm?l@
STl ek scifeh § <1 T8 ¥1d (condition) Ted & &1 STt |

6. Repeat Until- 38 Swglcl 51 § S statement el Tk Q&0 SITUT STl
W%gﬂ'@ﬂ@?‘lﬁ (condition) RO R RSl

7. Stop all- T8 F-2IcT scifesh o Te Tl St ahl Ush a7 |

319 fafs =T "Control" FHIE T ITTIT L 3T Tohdl YL FHTH i T TS

ToTerer Feyr- feteter aAedidt e ° Yfeana %Wﬁﬁ@ﬁ%ﬂﬂ:&’ﬁ
faf$=r Control sHTE foraTd |

e 43

% TS F foTT FesTioh 1 fewiee 7H x=0, y=0 2 |
*= T Event (SI2T) 98 € S 9I1¢d BT € 3T SHRT €41 3TTehiNd hid ¢ |

& T (sensing) 1 379 § fordlt cl%glﬁ olmq]%maﬁn%agrwm SREE]
AT |

% Frdicl scileh I8 T & S T Tieiae § T1gE o Tif Rt Frifa aea €
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1. Igferehedt ot

1. Toha 9T EYT2E o fewice s shr A 2 |

a) x=0, y=0 b) x=10, y=0
c) x=100, y=0 d) x= 100, y= 100
2. Statement hl TR AT oh TAT —-cmmmemeev Fralcd T T AT
o SImaT 2 |
a) Repeat until b) if...then
c) Forever d) repeat
. J— scATeh Tohel UL TS <l T farfer hl f=ifaa shear 2 |
a) Events b) Looks
c) Control d) Sensing

4. 31d G 7 B ok TITEE o 1 ol 280 o fog

qeic feRaT SITaT 2 |
a) Repeat until

c) Forever

2. FrafeRaa wet s 2

a.Events T % ?

b) if...then.

d) repeat

Fralcl HHTS
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b. Tohd T 3UASY fohedil I events o TH FIdTSU |

C. T H giATiod ht |

1. Forever

1. If.... Then

3. SR ST
I. S-SR Ueh i @ GEL i ok STl g3 Al oh1 Sshel H THHIH
ST |
1. T=faRaa s Ther 5 9T
a. @WW@@WWI
b. fereredt SITT-aTE Teh i & qE i deh gl @ |
c. STeT faiaeft Ueh i TR g & A1 SRt A I3 § |
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ey | ARV Sl B
R 7 Artificial Intelligence (=]

000000

AT deh BH T@T- Al WIEHH, WEdTE, dedie, TE T 3T TR
T oh ST | 91T |

ATTERiret geforsia A forivert shreget foeen grT ATHe fgwd Sisramsl
(Human Intelligence) @1 30T (Imitation) g | T3S & faRTe ﬂgﬂ'éiﬁ'lﬁ T

Expert System, EI'IECFI%I%“ TS JHERT (natural language translater), STeh 8=
(voice detection) 3R Af+ fosm Infie 2 |

v reniéfRire seforsia & SaeR" It fa=hteft (John McCarthy) € |
7.1 THTE B (Smart Home)

TS B U GIoTseh 8 Ue3T I HaHd FAT &, STel U0l i
TS IT AT A2deh (SATEH T IUANT hleh AT FRME & 1Y Fal o +ff
FATCTd &9 & TR ohar ST dehal & | TS B H 3TN SIS oh HIEAH 4§
HTOH H ST BId &, T8 TR ol 51 1 G, ATIHTH, JehTeT A€l ST M
foraet ig =it shi g0 o e st oAt giore forerd @ |

Smart Home
> ®» K
D 3G

Page | 74




R 7.2. = Em

7.2 Al- GATTTd SURIUT (Al-Powered devices)

AL-ENTeTd JUeRUT (Al-Powered

devices)
. HATATH B AT el &t qebd (Non-
JATITA W ATET (Voice Command) .
Voice Command)
Eg. Smart Speaker, Virtual Assistant Eg. Al Games, Google Lens
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7.2.1 TITE THTeRY (Smart Speaker)

TS TRt Ueh Jeh ohl ATSSHH I N I8 IS feamsd g | 399 Th
LS A AEE BT © S Th "8 € (Hot Word)" (FHE S “Ok
Google”) ! 7ag § $eifaed foraTd 371 SSH-3h1 i TaTH ShdT & | THIS TR

3D 3aTel0T Google, Nest, Audio, Alexa A |

!
|
|
. \

AMAZON ALEXA GOOGLE NEST AUDIO

e 7.3, wamd T
7.2.2 Ttz w (Video Game)

T (gaming) H ATCHTETT Efetsidr (THATS) A1 SUANT fohaT ST © aios
forell T3S Tie®M W g a1 RaeATiedt sl @et (game) T ATEdfdeh STIH

(realistic experience) I TohdT ST g | 3G8RT- BGMI, Fortnite, Grand Theft
Auto V.
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7.3 EF:EW AT (Virtual assistants)

THIA AL (VA) Toh HIFRAT &, ST ARl o $AYE (S HiRgeh
JTTEIT T T o ST T g ThT o hd AT HATU L HhaT 2 |
g WA H STANT] 3T S3Tel e 8 T4 I8 Hehd &, TqH H STHIRHT
SN o 1T Y Fej37et SATHEIE W STHSH ol ToiedT, T o1 R, ATgshiaiee
o1 IS ST I AREe A & | farfiret shufrart steret s1oft umesh Qe
HETIa | foreft 7 Toreft TR ol areletet STTede qehe1oh ohi SMTH L & |

Google Assistant Microsoft Cortana

s
Hey Siri, who are you?
Product Case Study of Apple's Voice Assistant

Apple Siri Amazon’s Alexa

o 7.5. sl sfede (V.AL)

7.4 TATE @wr\rg{&n (Smart Home Security)

T8 G TUTTe! Wik Seiarg 1ok Heehl ST Ueh T ¢, Sl 5L shl GL&T o6 [e1g
fireTeRt W X 2 |
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1. ¥HTE Tk (Smart Lock)
TTC ATeh Toh SoideiHehi-ohel Qieh @, ToTdl Tohdll USiiohd HieTSel feamsd €
SRR hIUS, SATHIH YO, THH hIS, sc[e AT A15-Hl3 o HIAH &
Geohd T 9T STaTST U ATTeRTT TR STQATTeRTT 3t oh oTT TSsTTeH foham T
2|

ot 7.6. T @R
ZWQTW%HTI‘ (Smart Security Camera)

THTE GRETT AL A AT <Al Rearfer am quf e o off ww fofean e ot
Tehd ¢ | I T: & ot T o1 STeurfl sh Wi o Teh AT Sl odT &
AT HES G0 HTToTeh ol Fierd L dT € | I8 24x7 T (et giiar e
& Toreer STkt Tt o STOT H o et SR A if et & |
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3. ¢ SRATH (Smart Doorbell)

THTE SRS Uk 32412 § (ST SISIeT @ Sil atalrst U fopeft HEHTH o 31 0t &
o HT(cTeh %l 34 fSATEH (FATEHIA AT fordlt 31T T1E) T o el & |

SMART DOORBELL
= 7.8. = Se A

4.'@1?5?13?: (Smart Light)

THTE TS Ueh SHE-UETH TISSl TATSE sloel & ST FohTel ohi L ¥ (e e
Tohd © | B SATSHI 3T 32T AT o7 (SAT$T) Scurert ot oft 0 &

o G SIS %l Sca1e H & Teh § |
& .

a
SMART LIGHTING
= 7.9. @ 9
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S.Wﬁﬁ'ﬁ'{(Smart Sensor)
THIS GO AT THTE TS, Teh gAieh IUSHLUT & ST STH-UTE o AT AT
SREISAT T UAT ST oh TIT HET 3hT ST T 8 | TTS HeX foreft +ff gee
U ST Teh HEaqUl Eeeh & | STeT shig He fohdll qte st oteiet ol udl
TR B, T I8 ATTeh GLET oeen 371 A ReeH o €19 | HT9eh Hiesa
I T STAC WST <77 |

= 7.10. = gww

= D

v Uk TS B9 T & HIfAeh! ahl 32TE e o HTETH & THICHIA AT Sl
T ITINT ek agﬁ ST <kl TRITSIA She <hl Gferer e T 2 |

v FHAA AEZ (VA) T HITe TSI 7, SIT STANTehd! 3T9E o STTIR T
ITANTRAT o AT g TR o h1 AT US4 TS HL GohdT 2 |

v/ 7% T YOI SR STTagi{-oh HeehT ohT Ush HWE & SiT B 3hi TLaT o forg
foreTent S SHLd ® |
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HAEJTH

1. T&t W e erreR

(A) "R gefersia & S 2-
(a) T 0T (b) STt Herhreff
(c) AT Sfolst (d) @ fifer

(B) Al arrefia feamg« 2-
(a) PR (b) TefifasH
(c) Tetera (d) vt

(C) THATA ATETE -
(a) T SAfEEE (b) HTERIETHE
(c) T (d) HEIF

(D) TTE HuaT st FfEra e o foTu srrarvaes uee #-
(a) ShET (b) THTEH
(c) ST Friferefardt (d) TTe et

2. Freferfaa oot & s

a) A.I (TRl sefersia) s g 2
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b) THTE B FET FAFS ek TEeh! hT ATH AT |

¢) T T AT E ? ATUTHT TETIehT oh hTS W1 ISTET
ferfau

d) R FATE ?

3. IR R
Toreneff 319 STTHUTE § Suctsy g A 1L feamses & 9 fafgu |

forerer o foru fsor: freres foenfofat st efver S & 3w g At Tt
T (AL Tools)/T3TE TR (A.1. Devices) o ST T STaTQ, ST foramffi =t
Yfereshct ek ff THSTE | SaTEX0T o AT e AR, STUSH T, A
o |
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Tfafarter-1

dferet | ferget =hT frer s sheeget o1 fort aITd el e o Wi -
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Tfeferfer-2

Tt | TRl G ShT STTeTeh ohi ShFt ok TE 1Y -
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